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Overview
This document includes information on installing, activating and configuring RTX 2016, based on the
common deployment scenarios described below. If the scenarios outlined in this document do not resolve
your deployment requirements, contact IntervalZero Sales.

Scenario 1: End User
The end user installs, activates and configures RTX. The method used to activate and configure will depend
on whether or not the user has network connectivity and .NET 4.0 installed.
View chapter

Scenario 2: Installing RTX Silently Within Your Product
RTX is wrapped within your product installation. Installation, activation and configuration of RTX is done
silently, but allows for end users to uninstall RTX without uninstalling your product.
View chapter

Scenario 3: Including RTX Merge Modules Within Your
Installation
RTX features - available as Merged Modules - are included with your product installation. Activation and
configuration of RTX is done silently after installation of your product, which includes RTX. RTX can only be
removed when your product is uninstalled.
View chapter

Scenario 4: Deploying RTX on Windows Embedded
Standard 7
Installation of RTX is done through the Windows Image Build Wizard and the Image Creation Editor.
Activation and configuration of RTX is done silently after the first boot of the WES 7 Operating System that
includes RTX.
View chapter

Scenario 5: Deploying RTX in an Image for Auto Activation
RTX is installed and configured for auto activation before an image is created for deployment.
View chapter
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Overview

License Types
Below are the two license types supported for RTX deployment. Throughout this guide, the recommended
license type is listed under each scenario.

Node Locked
A node-locked license ties RTX to a particular system or IntervalZero-provided dongle during product
activation. This license type supports:
l

Single activation – a single activation key licenses a single system

l

Pool activation – a single activation key licenses multiple systems
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Scenario 1: End User

In this scenario, a single end user installs RTX on their development machine, and activates and configures
RTX through the Activation and Configuration utility.

Product Installation
Before Installing
Before beginning the installation, do the following:
l

l

l

l

l

l

l

Review the RTX 2016, and verify that your configuration meets the system requirements.
You must have administrator privileges on your system. Log on with administrator privileges or start
the RTX installation using Run as Administrator.
IntervalZero recommends that you de-select the Windows “Automatically reboot” option for Startup
and Recovery from the Advanced tab of the System Properties page of the Windows Control Panel. Deselecting this parameter allows you to view blue screen information.
Exit all Windows programs.
If a previous version of RTX older than RTX 2016 is already installed on the system, you must uninstall it
and reboot the system before you can install RTX. If an update was applied to that previous version,
you must also manually uninstall the update.
RTX requires Microsoft .NET 4.0 to be installed on the system. If it is not already installed, you will be
prompted during install to have RTX install it for you.
If you have installed the standalone RTX Virtual Network Add-On, and you want to upgrade, you must
uninstall the standalone RTX Virtual Network Add-On and reboot the system before installing RTX.

NOTE: When you upgrade your operating system, you must uninstall and then reinstall RTX after the
OS upgrade.
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Performing the Install
To install RTX:
1. Download the self-extracting executable, RTX_2016_Setup.exe, from the IntervalZero web site:
http://www.intervalzero.com/products/rtx-downloads/
NOTE: The download page also includes:
l

The RTX Merge Module installer:
RTX_2016_MM_Setup.exe

For access to evaluation kits, visit the Evaluation page available at
http://www.intervalzero.com/.
In the form that appears, select RTX 2016 from the drop-down list, fill out the
contact information, and click Submit.
2. Double-click the file RTX_2016_Setup.exe.
NOTE: If Microsoft .NET 4.0 is not already installed on your machine, it will now be installed for
you. Click Install to continue.
3. On Windows 7 machines, if necessary, click Continue in the User Account Control dialog box.
NOTE: If you are not a member of the Administrators group, this prompt requires you to enter
the password for the Administrators account.
4. Click Next in the IntervalZero RTX installation Welcome window.
5. Read the End User License Agreement, select I accept the terms in the license agreement and then
click Next.
6. Enter your user name, organization, and e-mail address, and then click Next.
7. Optionally, change to a destination other than the default:
C:\Program Files\IntervalZero\RTX.
Click Next in the Destination Folder screen.
8. In the Custom Setup screen, select the components and features you want to install, then click Next.
NOTE: If you select the Win32 Enabled Managed Code Support feature during installation, the
Managed Code DLL will be registered by default.
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NOTE: The Custom Setup screen only displays features in Visual Studio versions that are
currently installed. If you install Visual Studio after installing RTX, you can add support for new
functionality by changing the RTX installation through Add/Remove Programs.
9. In the Ready to Install the Program screen, select whether you want Desktop Icons and/or Start Menu
Icons and then click Install.
10. If prompted, click Install to install the RTX Plug and Play driver.
11. Click Finish in the installation Completed screen.
12. Activate your product.

Product Activation and Configuration
The Activation and Configuration dialog appears once RTX has been successfully installed. You must activate
your RTX product and configure the boot configuration through this dialog.
NOTE:
When this symbol appears in the Activation and Configuration dialog, it indicates one of the
following scenarios:
l

l

The RTX Runtime component is installed and activated but not yet configured. To resolve
this, configure system processors through the Configuration screen.
A component was licensed by an Evaluation license which has since expired. To resolve
this, purchase a full license for the RTX component(s) you want to use.

Recommended License Type:
Node Locked – Single Activation. For more information, see License Types.

Activating your Product
You can activate and lock your product to a specific machine or IntervalZero-provided dongle. The steps
required to activate your product will depend on whether or not the machine is connected to the Internet.

Licensing your Product to a Machine
Follow the appropriate steps below to license RTX components to a specific machine.
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To activate your product (Internet connection):
1. Open the Activation and Configuration dialog. This dialog appears once RTX has been installed. You
can also launch it from Start > All Programs > IntervalZero > RTX 2016 > Activation and
Configuration.

If you have a dongle connected to the machine, click the dongle icon to turn off the dongle.
Icon:

Status:

Dongle recognized but turned off

Result:

Locks RTX component(s) to the machine

2. Make sure your machine is connected to the Internet with access to the IntervalZero License Server.

IZ-DOC-X86-0169-R1

6

Scenario 1: End User

Icon:

Status:

Network Connection

No Network Connection

Result:

Continue with activation

Configure a Proxy Server

If no network connection is found, make sure all network cables are plugged in and that the firewall
allows access, and click the Network icon to refresh. If a network connection still isn’t found, you may
need to configure a Proxy Server. To do this, click the Configure Proxy button and provide the
requested settings:

This information should be available from your IT department.
NOTE: The proxy server must be able to proxy HTTP connections. SOCKS proxies are not
supported.
NOTE: If no network connection can be established, skip to To activate your product (no Internet
connection).
3. Enter your activation key and then click Activate. The product components activated by your key are
indicated by a check mark in the Components box. Note that the RT-TCP/IP Stack requires a separate
license.
NOTE: You can find your activation key in the email you received from IntervalZero Sales.
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4. Click Configure to configure system processors. See Configuring your System below for more
information.
IMPORTANT! You must configure the RTX Subsystem before you can use RTX.

To activate your product (no Internet connection):
If the computer on which you installed RTX is not connected to the Internet, the activation process requires
a few additional steps.
1. Open the Activation and Configuration dialog. This dialog appears once RTX has been installed. You
can also launch it from Start > All Programs > IntervalZero > RTX 2016 > Activation and
Configuration.

If you have a dongle connected to the machine, click the dongle icon to turn off the dongle.
Icon:

Status:

Dongle recognized but turned off

Result:

Locks RTX component(s) to the machine

2. Check your Internet connection. Continue with these steps only if there is no connection to the
Internet. If you are connected, follow the steps in the previous section:
3. Enter your activation key and then click Activate.
NOTE: You can find your activation key in the email you received from IntervalZero Sales.
NOTE: If you enter an invalid activation key, you will not know until you attempt to generate a
license file in Step 11.
4. In the dialog that appears, click Yes to create a fingerprint file.
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5. In the Save As dialog, name the file fingerprint.rfp. By default, the file will be saved to the
desktop.
6. Navigate to the desktop, and then copy and paste the file fingerprint.rfp to an external device.
7. Connect the device to a machine with Internet connectivity.
8. Launch a web browser, and navigate to http://Activation.IntervalZero.com.
9. Browse for and open the file fingerprint.rfp.
10. Read and agree with the Terms & Conditions.
11. Click Activate to generate a license (.lic) file.
12. In the File Download dialog, click Save.
13. Copy the file License.lic to the external device, and transfer it to the machine on which RTX is
installed.
14. In the Product Activation dialog, click Import License.

15. Browse for and open the file License.lic.
16. Click Configure to configure system processors. See Configuring Your System below for more
information.
IMPORTANT! You must configure the RTX Subsystem before you can use RTX.
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Licensing your Product to a Dongle
Follow the appropriate steps below to license RTX components to an IntervalZero-provided dongle.
Dongles are available in two sizes:
Small Form Factor

Standard

Supported RTX Versions

RTX 2016

All

Holds a copy of the license
file

Yes

No

If you have a dongle that has already been activated for the components you have installed, skip to section
To use a dongle that has already been activated.
NOTE: You can also license RTX components to an IntervalZero-provided dongle using the Dongle
Activation Utility. The IntervalZero-provided Dongle Activation Utility can be used to pre-activate
licensed components on machines where RTX is not installed. You can download the Dongle
Activation Utility from the IntervalZero website at http://www.intervalzero.com/rtx-downloads/toolsutilities/.
IMPORTANT! You cannot license RTX components to a dongle when more than one dongle is
connected to the machine.

To activate your product (Internet connection):
1. Open the Activation and Configuration dialog. This dialog appears once RTX has been installed. You
can also launch it from Start > All Programs > IntervalZero > RTX 2016 > Activation and
Configuration.
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2. Connect the IntervalZero-provided dongle to the machine now. When a dongle is connected to the
machine, a dongle icon appears in the Activation and Configuration dialog.

Icon:
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Status:

Dongle recognized and
available

Dongle is connected but
turned off. Click the icon to
enable the dongle.

Multiple dongles detected

Result:

Locks RTX component(s) to
the dongle

Locks RTX component(s) to
the machine

You cannot license RTX
components to a dongle
when more than one dongle
is connected to the machine.

IMPORTANT! Once components are locked to a dongle, the dongle must be connected in order
to use RTX components on that machine.
3. Make sure your machine is connected to the Internet with access to the IntervalZero License Server.
Icon:

Status:

Network Connection

No Network Connection

Result:

Continue with activation

Configure a Proxy Server

If no network connection is found, make sure all network cables are plugged in and that the firewall
allows access, and click the Network icon to refresh. If a network connection still isn’t found, you may
need to configure a Proxy Server. To do this, click the Configure Proxy button and provide the
requested settings:
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This information should be available from your IT department.
NOTE: The proxy server must be able to proxy HTTP connections. SOCKS proxies are not
supported.
NOTE: If no network connection can be established, skip to To activate your product (no Internet
connection).
4. Enter your activation key and then click Activate. The product components activated by your key are
indicated by a check mark in the Components box. Note that the RT-TCP/IP Stack requires a separate
license.
NOTE: You can find your activation key in the email you received from IntervalZero Sales.
5. Click Configure to configure system processors. See Configuring your System below for more
information.
IMPORTANT! You must configure the RTX Subsystem before you can use RTX.

To activate your product (no Internet connection):
If the computer on which you installed RTX is not connected to the Internet, the activation process requires
a few additional steps.
1. Open the Activation and Configuration dialog. This dialog appears once RTX has been installed. You
can also launch it from Start > All Programs > IntervalZero > RTX 2016 > Activation and
Configuration.
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2. Connect the IntervalZero-provided dongle to the machine now. When a dongle is connected to the
machine, a dongle icon appears in the Activation and Configuration dialog.

Icon:
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Status:

Dongle recognized and
available

Dongle is connected but
turned off. Click the icon to
enable the dongle.

Multiple dongles detected

Result:

Locks RTX component(s) to
the dongle

Locks RTX component(s) to
the machine

You cannot license RTX
components to a dongle
when more than one dongle
is connected to the machine.

IMPORTANT! Once components are locked to a dongle, the dongle must be connected in order
to use RTX components on that machine.
3. Check your Internet connection. Continue with these steps only if there is no connection to the
Internet. If you are connected, follow the steps in the previous section:
4. Enter your activation key and then click Activate.
NOTE: You can find your activation key in the email you received from IntervalZero Sales.
NOTE: If you enter an invalid activation key, you will not know until you attempt to generate a
license file in Step 12.
5. In the dialog that appears, click Yes to create a fingerprint file.

6. In the Save As dialog, name the file fingerprint.rfp. By default, the file will be saved to the
desktop.
7. Navigate to the desktop, and then copy and paste the file fingerprint.rfp to an external device.
8. Connect the device to a machine with Internet connectivity.
9. Launch a web browser, and navigate to http://Activation.IntervalZero.com.
10. Browse for and open the file fingerprint.rfp.
11. Read and agree with the Terms & Conditions.
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12. Click Activate to generate a license (.lic) file.
13. In the File Download dialog, click Save.
14. Copy the file License.lic to the external device, and transfer it to the machine on which RTX is
installed.
15. In the Product Activation dialog, click Import License.

16. Browse for and open the file License.lic.
17. Click Configure to configure system processors. See Configuring your System below for more
information.
IMPORTANT! You must configure the RTX Subsystem before you can use RTX.

To use a dongle that has been pre-activated:
If the dongle you have received has already been pre-activated, you only need to:
Small Form Factor

Standard

Plug in the dongle (the license file is already on the
dongle)

Import the license file

1. Connect the IntervalZero-provided dongle to a USB port on the machine.
2. Open the Activation and Configuration dialog. This dialog appears once RTX has been installed. You
can also launch it from Start > All Programs > IntervalZero > RTX 2016> Activation and
Configuration.
3. Make sure the Activation and Configuration utility recognizes the dongle:
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Icon:

Status:

Dongle recognized and available

Result:

Locks RTX component(s) to the dongle

If the dongle is not recognized, make sure it is securely connected to your machine. Proceed once you
see the Dongle Active icon.
Steps 4-5 are for Standard dongles only:
4. In the Product Activation dialog, click Import License.

5. Browse for and open the file License.lic you received with the activated dongle.
NOTE: The license is locked to the dongle. The dongle must be connected to the machine in
order to use RTX components.
6. Click Configure to configure system processors.
NOTE: You must configure the RTX Subsystem before you can use RTX.

Configuring your System
Through the Configure screen, you can assign available processors to Windows or RTX. The configuration
routine automatically detects the total number of processors on your system.
NOTE: If your system is hyper-threaded, it is recommended that you assign an even number of
processors between Windows and RTX. The Windows logical processor and RTSS logical processor
must not share the same physical processor.
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To assign processors:
1. In the Activation and Configuration dialog, click Configure to configure system processors. You can
assign processors between Windows and RTX. There must be at least one Windows processor
(indicated by the lock). Based on the edition purchased, you will have a maximum number of processors
that can be used for RTX, as shown in the text of the dialog.
NOTE: Any processors not associated with either Windows or RTX will be disabled and
unavailable for use.

2. Click Done to complete configuration.
3. When you are prompted, click Yes to restart your computer.
NOTE: On Windows 8.1, configuration changes will only take effect following a restart, not a
shutdown.
4. Choose the RTX boot configuration at system startup:
l

Windows 8.1: Windows 8.1 - RTX

l

Windows 7: Windows 7 - RTX
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NOTE: The RTX control panel will not provide completely accurate information until you reboot
your system.
NOTE: Even if you don't restart immediately, all changes will be saved and will take affect after
the next restart.
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2
Scenario 2: Installing RTX Silently

In this scenario, the installation, activation and configuration of RTX is done silently through a Command
Prompt interface to the RTX Runtime product installation. The command line interface can be invoked from
the command line or used within your own product installation process so as not to require user interaction
during the RTX installation process.
The method used to activate and configure will depend on whether or not the user has network
connectivity.

Product Installation
Before Installing
Before beginning the installation, do the following:
l

l

l

l

l

Review the RTX 2016 Silent Install Guide.
Verify that your configuration meets the system requirements described in the RTX 2016 Silent Install
Guide.
You must have administrator privileges on your system. Log on with administrator privileges or start
the RTX installation using Administrator privileges.
RTX requires Microsoft .NET 4.0 to be installed on the system. If it is not already installed, you will be
prompted to have RTX install it for you.
You must reboot the system after RTX is installed.
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Getting the Installation Package
This release can be downloaded from IntervalZero's website or copied from the IntervalZero CD.
NOTE: The RTX Runtime components are also available as merge modules that can be included in the
installation of an OEM product. See Scenario 3: OEM Including RTX Merge Modules Within Their
Installation for more information.

Performing the Install
The silent installer provides the ability to install the RTX Runtime from the command line. This makes it
possible to install the RTX runtime within another product installation. Take note of the following
information before you begin.
l

l

If a previous version of RTX is already installed on the system, you must uninstall it and reboot the
system before you can install RTX. If an update was applied to that previous version, you must also
manually uninstall the update.
Administrator privileges are required — Installation must be done from an account that has
administrator privileges. This can be done in one of several ways:
l

From any version of Windows:
a. Right-click to start a command prompt and select Run as... from the pop-up menu.
b. After the command prompt appears, run the installer using the options described under
Installation Options.

l

From a pre-Vista version of Windows:
a. Log onto an account with administrative privileges and begin the installation as described in
this document.

Installation Command Line Parameters
MSI Supported Options
The RTX Silent Installer uses the standard Windows Installer Component (msiexec.exe) to perform the
installation. You can use other supported msiexec.exe options if desired. For a full list of options, enter
this command in a Command Prompt:
msiexec.exe /?
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Option

Description

/s

Optional. Makes the setup.exe run silently.

/v

Optional. Tells setup.exe to pass the quoted parameters into msiexec.exe.

/qn

Required. Tells msiexec.exe to run silently.

Unsupported Options
The following options are not supported. If used, an error message will appear and setup will abort.
Option

Description

/a

Administrative install
IMPORTANT! An administrative install, performed using the /a option,
is not the same as “running with administrative permissions”. The RTX
Runtime Silent Installation must be run with administrative permissions,
as explained in this document. An administrative install is performed to
a network for the purpose of making a product available to users in a
workgroup. This type of group-wide installation is not supported by
RTX.

/j

Advertise a product

Available RTX Options
Option

Description

ADDLOCAL

Optional. Used to select which features to install on the system. See
ADDLOCAL Options for more information.

RTXDIR=<Directory>

Optional. Installation directory. If you omit this parameter, the
installation process installs RTX Runtime into this directory:
<WINDISK>\Program Files\IntervalZero\RTX
where <WINDISK> represents the disk on which Windows is currently
installed. If you use this parameter, your installation process is
responsible for verifying that the disk exists and the directory is valid
and writeable.

DT_ICONS
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icons to the desktop. If you want RTX to be hidden from the user, do
not use this parameter.
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SM_ICONS

Optional. The SM_ICONS parameter instructs the installer to add RTX
to the Start menu. If you want RTX to be hidden from the user, do not
use this parameter. Users can still access RTX Properties from the
Control Panel. When this parameter is not specified, no start menu
icons are displayed.

NOTE: Icons are installed by default. You can suppress them by including DT_ICONS=0 and SM_
ICONS=0. For example:
RTX_2016_Setup.exe /s /v"/qn ADDLOCAL=HeadersAndLibraries,Tools,VS130 DT_ICONS=0
SM_ICONS=0
RTXDIR=\"C:\Program Files\IZ\RTX\""

ADDLOCAL Options
Arguments to the RTX Silent Installer ADDLOCAL parameter are shown in the table below. RTX uses MSI
logic to handle selection of features during silent installation. You can implement the ADDLOCAL property to
define a comma-delimited list of features to install.
Option

Description

Documentation

Optional. Information on using the Subsystem, utilities, and tools.

HeadersAndLibraries

Optional. Headers and libraries needed to build RTSS applications.

Subsystem

Optional. Drivers and utilities that make up the RTX Subsystem.

DotNetRuntimeSupport

Optional. Installs runtime support for .Net.

RTTCPIPSupport

Optional. Includes the RTX realtime TCP/IP stack and a number of NIC
drivers.

Samples

Optional. Sample applications using the RTX Subsystem.

Tools

Optional. A set of tools and utilities for diagnosing issues and
monitoring performance.

SampleSource

Optional. Useful sample application code. This includes device driver
samples, as well as RTSS application samples, and Win32 samples
showing how to adjust RTX properties programatically.

Symbols

Optional. Debugging symbols for the RTX Subsystem.

MSVSSupport

Optional. Wizards and debugger add-ins for Microsoft Visual Studio.

VS2013
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2013.
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VS2015

WinDbgSupport

Optional. Wizards and debugger add-ins for Microsoft Visual Studio
2015.
Optional. Real-time debugging support for Microsoft WinDbg.

The installer looks through the entire list of ADDLOCAL parameters provided, and if an option is found that
isn't recognized as a valid switch by the installer, an error message is displayed and the installation will not
continue.
NOTE: Selecting a sub-feature will automatically select its parent. For example, including
RTTCPIPSupport will automatically include Subsystem.

Format
The following two examples would produce identical results:
RTX_2016_Setup.exe /s /v"/qn
ADDLOCAL=Welcome,Documentation,HeadersAndLibraries,Subsystem,DotNetRuntimeSupport,RTTCPIPSupport,
Samples,Tools,SampleSource,Symbols,MSVSSupport,VS80,VS90,VS100,VS110,WinDbgSupport"
and
RTX_2016_Setup.exe /s /v"/qn ADDLOCAL=ALL"
In the example below, only the Runtime with Tools, Headers and Libs, and Visual Studio 2010 Support is
installed:
RTX_2016_Setup.exe /s /v"/qn ADDLOCAL=HeadersAndLibraries,Tools,VS100"
For more information, see the RTX 2016 Silent Install Guide.

Product Activation and Configuration
You can activate your product and configure the RTX boot configuration using a Command Line utility

Recommended License Type:
Node Locked – Pool Activation. For more information, see License Types.
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Activating your Product
To activate your product (Internet connection required):
1. Navigate to the RTX\bin directory and run RtxActivationUtil.exe as Administrator.
2. Type the -a flag, and then provide your activation key. For example:
RtxActivationUtil.exe -a IZRTX-111-2222-3333-4444-5555-TCP-111-2222-33334444-5555-IZSDK-111-2222-3333-4444-5555
NOTE: You can find your activation key in the email you received from IntervalZero Sales.
3. If running from a command prompt, the activated components are displayed:

Configuring your System
Setting the boot configuration (.NET 4.0 required):
1. Navigate to the RTX\bin directory.
2. Run RtxActivationGUI.exe as Administrator.
3. Provide the number of Windows -w and RTSS -r processors. For example, to assign 3 processors to
Windows and 5 processors to RTX, you would type:
RtxActivationGUI.exe -w 3 -r 5
4. Restart the system.
NOTE: For complete usage information, see Appendix A: RTX Activation and Configuration Usage.
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3
Scenario 3: Including RTX Merge
Modules within Your Installation

In this scenario, RTX is installed by including RTX Merge Modules within your own product installation
process. Activation and configuration occurs silently on the target system after installation is completed.

Product Installation
Before Installing
l

Before starting installation of RTX, review the system requirements in the RTX Install Guide for Merge
Modules.

Performing the Install
To install RTX Merge Modules:
1. Download the self-extracting executable, RTX_2016_MM_Setup.exe, from the IntervalZero web site:
http://www.intervalzero.com/rtx-2016-downloads/#tab-1
NOTE: For access to evaluation kits, visit the Evaluation page at
http://www.intervalzero.com/.
In the form that appears, select RTX 2016 from the drop-down list, fill out the
contact information, and click Submit.
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2. Double-click the RTX_2016_MM_Setup.exe.
3. Click Next in the IntervalZero RTX Merge Modules installation Welcome window.
NOTE: If Microsoft .NET 4.5.1 is not already installed on your machine, it will now be installed
for you. Click Install to continue.
4. Read the End User License Agreement, select I accept the terms in the license agreement and then
click Next.
5. In the Custom Setup screen, view the default features that will be installed, make any changes if desired
and then click Next.
6. In the Ready to Install the Program screen click Install.
7. View the status bar as the installation proceeds.
8. Click Finish in the installation Completed screen.

Files Added During Installation
The RTX Merge Modules installation adds files to the following directory:
c:\Program Files\IntervalZero\RTX Merge Modules
Merge Modules can be found in the subdirectory
\Repository\MergeModules
The merge modules that are installed include:
l

haspds.msm

l

RtxManaged.msm

l

RtxSubsystem.msm

l

RtxTcpip.msm

l

RtxTools.msm

l

RtxPrereq.msm

l

VirtualNic.msm

Samples can be found in:
\Samples\InstallShield2008\SampleInstall.ism
l

Sample InstallShield Setup Project file
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\Samples\VisualStudio9Setup\VSISample.vdproj
l

Sample Visual Studio Installer Merge Module Project

Merge Module Deployment
Once the merge modules have been installed onto the development system, they can be included in a setup
file that will be installed on a target system.

Runtime Installation Requirements
In addition to the target machine operating system requirements listed at the start of this document, take
note of the following information when RTX merge modules are added to an installation.
l

l

Administrator privileges are required — Installations using RTX merge modules must be done from
an account that has administrator privileges.
You must reboot after RTX has been installed.

Merge Module Dependencies
If any of the RTX merge modules are added to an installation, they must include the RTX Subsystem, which is
contained in the merge module file RtxSubsystem.msm.

Merge Module Properties
Before adding the RTX Runtime merge modules to an installation kit, note the mandatory and optional
properties listed in this section.
Error messages are listed at the end of this document.
Property

Description

Set to...

EMAILADDRESS Optional. User email address.
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Property

Description

Set to...

RTX_ERROR_
DISPLAY

Optional. Used to determine how
error messages will be displayed.

One of the following:

If this property is not added, the
default behavior is Message box
error display.

MessageBox – Custom action error messages
will be displayed in a message box as they do
during a normal RTX installation.
StringRegVal – The full text of an error
message will be written into the registry
location "InstallError" under the key
SOFTWARE \Microsoft\Windows
\CurrentVersion \Uninstall \{E1A7EFBE-9B1A4517-BEF8-659A55AA93B4}
NumRegVal – The error number of an error
will be written into the registry location
"InstallError" under the key SOFTWARE
\Microsoft\Windows \CurrentVersion
\Uninstall \{E1A7EFBE-9B1A-4517-BEF8659A55AA93B4}

RTX_
WARNING_
DISPLAY

Optional. Used to determine how
One of the following:
warning messages will be displayed.
MessageBox – Custom action warning
If this property is not added, the
messages will be displayed in a message box
default behavior is MessageBox
as they do during a normal RTX installation.
error display.
StringRegVal – The full text of a warning
message will be written into the registry
location "InstallWarning" under the key
SOFTWARE \Microsoft\Windows
\CurrentVersion\Uninstall \{E1A7EFBE-9B1A4517-BEF8-659A55AA93B4}
NumRegVal – The error number of a warning
will be written into the registry location
"InstallWarning" under the key SOFTWARE
\Microsoft\Windows
\CurrentVersion\Uninstall \{E1A7EFBE-9B1A4517-BEF8-659A55AA93B4}
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Property

Description

Set to...

RTXDIR

Required. Used to determine where Directory location (will be created if it does
the RTX subsystem files will be
not exist).
installed. Default is
“%ProgramFiles%\IntervalZero\RTX”
or C:\Program
Files\IntervalZero\RTX

DT_ICONS

Optional. Used to instruct the
installer to add RTX icons to the
desktop.

1 to enable. Otherwise, the default is for icon
addition to be disabled.

SM_ICONS

Optional. Used to instruct the
installer to add RTX to the Start
menu.

1 to enable. Otherwise, the default is for Start
menu addition to be disabled.

Target Activation and Configuration
Once RTX is installed on your target system, you must activate the RTX product and configure system
processors using a Command Line utility.

Recommended License Type:
Node Locked – Pool Activation. For more information, see License Types.

Activating your Product
To activate your product (Internet connection required):
1. Navigate to the RTX\bin directory and run RtxActivationUtil.exe as Administrator.
2. Type the -a flag, and then provide your activation key. For example:
RtxActivationUtil.exe -a IZRTX-111-2222-3333-4444-5555-IZTCP-111-2222-33334444-5555-IZSDK-111-2222-3333-4444-5555
NOTE: You can find your activation key in the email you received from IntervalZero Sales.
3. If running from a command prompt, the activated components are displayed:
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Configuring your System
Setting the boot configuration (.NET 4.0 required):
1. Navigate to the RTX\bin directory.
2. Run RtxActivationGUI.exe as Administrator.
3. Provide the number of Windows -w and RTSS -r processors. For example, to assign 3 processors to
Windows and 5 processors to RTX, you would type:
RtxActivationGUI.exe -w 3 -r 5
4. Restart the system.
NOTE: For complete usage information, see Appendix A: RTX Activation and Configuration
Usage.
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4
Scenario 4: Installing on Windows
Embedded Standard 7

In this scenario, RTX installation is accomplished through the Windows Image Build Wizard, the Image
Creation Editor, and RTX Silent install. RTX activation and configuration is completed silently after the first
boot of the full Operating System that contains RTX.
NOTE: RTX requires .NET 4.0 for configuration on Windows 7 systems.

Product Installation
This section will walk you through the steps necessary to create a Windows Embedded Standard 7 image
that includes the RTX Runtime.

WES7 Image Creation Steps
Creating an image that includes the RTX Runtime requires the following steps:
l

Install the Windows Embedded Standard 7 Toolkit.

l

Start the Image Configuration Editor.

l

Create an Answer File (AF).

l

Select a Distribution Share (DS).

l

Add the RTX Silent Installer to the Distribution Share.

l

Add the RTX installation command to the Answer File.

l

Add Additional Components to the Image.

l

Analyze Installation Kit Dependencies.

IZ-DOC-X86-0169-R1

32

Scenario 4: Installing on Windows Embedded Standard 7

l

Validate the Answer File.

l

Create Image Files.

l

Create a Bootable Device.

l

Add Image Files to the Device.

l

Boot the WES7 Install on the Target System

l

Customize the Image.

l

Activate RTX.

Create Image Using ICE
The Image Configuration Editor (ICE) allows you to create an answer file that will define the components and
settings for your target installation.

Start the Image Configuration Editor:
Once the Windows Embedded Standard 7 Toolkit has been installed, start the Image Configuration Editor
from the Start menu by selecting:
Windows Embedded Standard 7 > Image Configuration Editor

Create an answer file:
To create a new answer file
From the File menu, select New Answer File.
NOTE: The new answer file has a default name of Untitled. To name the file, save the answer file by
selecting Save Answer File from the File menu. For now, ignore validation errors as they will be
corrected later.

Select a distribution share:
All components that will be used to build the image are stored in a distribution share (DS) folder. Using a
shared folder allows the same source to be used to create multiple images. Preconfigured, default
distribution shares include:
l

C:\Program Files\Windows Embedded Standard 7\DS
For a 32-bit distribution built on a 32-bit development computer
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l

C:\Program Files\Windows Embedded Standard 7\DS64
For a 64-bit distribution share built on a 32-bit development computer

Since IntervalZero RTX Runtime supports only the 32-bit version of WES7, to ensure you have the correct
distribution share:
1. Right-click the directory specification under the Distribution Share heading.
2. Click Select Distribution Share from the pop-up menu.
3. Browse to and then double-click:
C:\Program Files\Windows Embedded Standard 7\DS
NOTE: This assumes that Windows Embedded Standard 7 was installed in the default directory.

Add the RTX Runtime Installer to the distribution share:
The distribution share should contain all components needed to build the image. To include the RTX
Installer in the image, it must be added to a subdirectory of the distribution share. To do this:
1. Right-click the directory name at the top of the Distribution Share tree.
2. Select Explore Distribution Share... from the pop-up menu.
3. When an explorer window pops up:
a. Browse to (or create, if it does not exist) the following subdirectory in the distribution share
directory tree.
<DS>\$OEM$ Folders\Custom Files\$OEM$\$1
Where the default value of <DS> is C:\Program Files\Windows Embedded Standard
7\DSSP1.
b. Copy the RTX Runtime installer (RTX_2016_Setup.exe) to this subdirectory
NOTE: The \$OEM$\$1 directory represents the root of the drive onto which you will install Windows
Embedded Standard 7.
To ensure files in this $OEM$ directory and subdirectories are included in your image:
1. Right-click the Answer File (name, or "Untitled" if it has not yet been saved).
2. In the pop-up menu, click Insert Oem Folders Path.
3. Browse to <DS>\$OEM$ Folders\Custom Files\$OEM$
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After the command has been added, you can see it by browsing the Answer File pane to
Product\Operating System\Foundation Core\Windows Embedded Edition\Setup_x86,
and then look for PathAndCredentials under OEMFoldersPaths in the Settings pane.
For more information, refer to the MSDN article:
Add Custom Files and Folders Using Image Configuration Editor

Add the RTX installation command to the answer file:
ICE allows the developer to add custom commands to the answer file. To perform an installation of the RTX
Runtime, add it to the answer file as follows:
1. Right-click the Answer File (name, or Untitled if it has not yet been saved).
2. In the pop-up menu, click Insert Synchronous Command to Pass 7 oobeSystem.
3. Enter the RTX Runtime installation command using the full directory path.
4. Set the Order value to 2
5. Click OK.
As noted above, since the Installer file was copied to the \$OEM$\$1 subdirectory, an example of the
command line would be :
C:\RTX_2016_Setup.exe

For information on installing the RTX Runtime Silently, see the RTX Silent Install Guide.
NOTE:
After the commands have been added, you can see them by browsing the Answer File pane to
Product\Operating System\Foundation Core\Windows Embedded Edition\ShellSetup_x86, and then looking for CommandLine under the FirstLogonCommands, Synchronous
Commands in the Settings pane.
After the RTX Runtime install command has run, you must reboot your system for the RTX Runtime
installation to complete.
After the target system boots and the RTX Runtime installation has run, the install kits will still reside in
the base directory. You can optionally add a second synchronous command to remove the file, such as:
cmd /c del "C:\RTX_2016_Setup.exe"
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Add additional components to the image:
A new WES7 answer file begins with the Windows Embedded Edition Foundation Core component.
Additional components are selected by the user. RTX requires both the Windows Installer and the Device
Driver Frameworks.
Follow these instructions to add each component:
1. Expand the Distribution Share to locate the component.
2. Right-click the component.
3. From the pop-up menu, click Add to Answer File.
A new WES7 answer file requires the following components:
l

Packages > FeaturePack >.NET Framework > .NET Framework 2.0 Client Profile

l

Packages > FeaturePack >.NET Framework > .NET Framework 3.0 Client Profile

l

Packages > FeaturePack >.NET Framework > .NET Framework 3.5 Client Profile

l

Packages > FeaturePack > System Services > Windows Installer

l

Packages > FeaturePack > Devices and Printers > Driver Frameworks

l

Packages > FeaturePack > Management > Windows Application Compatibility

l

Packages > FeaturePack > Management > Windows Updates

l

Packages > FeaturePack > Management > System Management > Group Policy Management

l

Packages > FeaturePack > Management > System Management > System Management
Administration

l

Packages > FeaturePack > Management > System Management > System Management Utilities

l

Packages > FeaturePack > Management > Power Management

l

Packages > FeaturePack > Networking > Remote Access Service (RAS) (required for activation over
a network connection)

NOTE: RTX requires .NET 4.5.1 for configuration on Windows 7 systems.
Additional components can be added either by selecting them individually, or by including a template that
contains a common group of features. The WES7 kit provides the ability to use one of several predefined
templates. To view and select one of these, do the following:
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1. Expand the Distribution Share to locate Templates > IBW.
2. Right-click a template.
3. Select Add to Answer File from the pop-up menu.
NOTE: Once you have selected each of the components that you want to include, you can save your
own template to be used as an initial starting point for future image builds.

Analyze installation kit dependencies:
The Image Configuration Editor provides a tool to analyze a silent installer file and determine what
components it depends upon. Analyze the RTX Runtime installation file as follows:
1. From the Tools pull-down menu, select Analyze Static Dependencies.
2. Browse to the RTX_2016_Setup.exe file that was added to your selected distribution share.
3. A pop-up status window will appear while static dependencies are being analyzed.
4. In the Analyze Static Dependencies window
l

Select Required Packages.

l

Enter a name for the file subfolder (such as RtxDependencies).

l

Click OK.

The selected components will now be in the Answer File.

Validate the answer file:
The new answer file will include the Windows Embedded Edition Foundation Core and any additional
components you have added. Some of the components that were added will have required dependencies
and others will allow you to select from a group of optional dependencies. To ensure that all required and
optional dependencies are included,
1. From the Validate menu, select Validate Only.
2. In the Messages Pane at the bottom of the window, double-click each validation description and select
optional and required components from the Resolve Dependencies window.
Repeat the steps above until no more validation errors are displayed.
NOTE: After making any changes to the answer file (such as adding components or importing a
template) you should repeat the validation steps to ensure any dependencies are satisfied and then
save the answer file using File > Save Answer File.
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Create image files:
Once all selections have been made and the Answer File has been saved, create image files that will be
copied to a bootable device. Create the Windows Image Builder Wizard (IBW) files using:
Tools > Create Media > Create IBW Image from Answer File
Select a directory location to store the IBW image files. Remember this directory location, as it will be needed
when the image is put onto a bootable device. For example, C:\temp\IBW_wRTX_Image.
Optional installation procedure: This MiniTutorial walks you through the steps needed
configure a single device that will boot and then automatically begin setup of the WES7 install.
It is also possible to install WES7 after booting from a lightweight or preinstallation
environment (PE) version of Windows. To do that, see the section titled Installing From PE Image
at the end of this document.
Once the image has been saved, you can exit the Image Configuration Editor.

Put Image Files onto a Bootable Device
To install the new Windows Embedded Standard 7 onto your target, you must first create a bootable device.
The steps needed to create bootable media that will automatically run Setup from the IBW image are listed
below.
1. Create a bootable device (USB flash drive, CD-ROM disk or other bootable media).
2. Copy all files from the IBW image directory to the bootable device.
3. Boot the target system from the newly configured device and setup of the IBW image files will
automatically begin.
Instructions for creating a bootable USB Flash Drive (UFD) and for creating a bootable CD-ROM are given
below. Select one of these, or read the following MSDN article for help with other device options:
Image Builder Wizard – Quick and Easy Embedded OS Creation
NOTE: Instructions are given for creating a bootable UFD and for creating a bootable CD-ROM. Other
media that can be booted on your system can also be used. Only one media type needs to be selected
and created.

Create a bootable UFD with IBW image files:
To create a bootable USB Flash Drive (UFD) open a command prompt with Administrator privileges and use
the diskpart utility as shown below. These instructions can also be found in the MSDN article titled Create a
Bootable Utility UFD.
NOTE: The diskpart utility in Windows XP does not show removable storage in a disk list. So, this
step should be performed using a Windows Vista or Windows 7 system.
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1. Start the disk partition tool:
diskpart
2. Determine your disk number:
list disk
3. Select your device
select disk <disk_number>
4. Remove partition and volume information
clean
5. Create a primary partition
create partition primary
6. Set focus to the newly created primary partition
select partition 1
7. Mark the partition with focus as a valid system partition
active
8. Format the partition
format FS=ntfs LABEL=<Label> QUICK
9. Assign a drive letter to the partition
assign
or
assign LETTER=<L>
10. Exit the diskpart utility
exit
Copy all files from the IBW image directory to the bootable UFD using the following command:
xcopy

C:\temp\IBW_wRTX_Image\*.*

/s

/e

/f

L:\

where C:\temp\IBW_wRTX_Image is your IBW image file directory and L:\ is your UFD drive letter.

Create a bootable CD-ROM with IBW image files:
To create a bootable CD-ROM with IBW image directory files, you must first create an ISO that contains a
bootable image of the IBW directory as follows:
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1. From the Start menu on the development computer, select
All Programs > Windows Embedded Standard 7 >
Windows PE Tools Command Prompt
A Windows PE Tools Command Prompt window opens.
2. At the Windows PE Tools command prompt, use the Oscdimg tool to create an ISO file that has the
contents of the image directory you created, using the ETFSBOOT.COM command located in the BOOT
subdirectory. For example, if your image directory is C:\temp\IBW_wRTX_Image and you want to
create your ISO in C:\temp\, called IBW_wRTX.iso type the following:
oscdimg -n -bc:\temp\IBW_wRTX_Image\BOOT\ETFSBOOT.COM C:\temp\IBW_wRTX_Image
C:\temp\IBW_wRTX.iso
Where parameters to oscdimg are:
-n allow long names
-blocation - Location of boot sector file (no space after the "b")
Location of image source files
Location of target ISO file
The Oscdimg command above will create a bootable ISO file named IBW_wRTX.iso in the c:\temp\ folder.
Using CD-ROM burning software, burn the ISO file to a blank CD-ROM.
For more information, refer to the MSDN article: Create and burn the ISO file to a CD-ROM

Boot the WES7 Install on the Target System
The Image Configuration Editor allows you to create an answer file that includes the components and
settings for an image that will be installed onto your target system.
Before booting your image, check that the system BIOS is set to ensure that the boot order includes the
device that you have built your IBW image onto.
After inserting your boot media, the following should occur:
l

Messages will display indicating:
n

Windows is loading files

n

Starting Windows

n

Setup is Starting

l

License agreement will be displayed. Read and accept terms and click Next.

l

Language preferences will be displayed. Select and click Next.

l

Available disks will be displayed.
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l

n

Select the disk for the target installation.

n

To format the disk, expand drive options and select Format.

n

To use the selected disk click Next.

Windows installation messages will appear including:
n

Copying Windows files

n

Expanding Windows files

n

Installing features and updates

The system will reboot to apply system settings. When the system comes back up, the Windows Boot
Manager will include Windows Embedded Standard as a new boot option.
NOTE: If using a bootable UFD, remove it after system files have been copied, and before a reboot
occurs.

Customize the Image
The first time you start your image, the following setup prompts will appear.
l

Username and Computer name

l

An optional user password

l

Product key

Customization will continue after selecting one of the following:
l

User recommended settings

l

Install important updates only

l

Ask me later

The last prompt will be for time and date settings.
After screens for Welcome and Preparing your desktop the RTX Runtime installation will occur.
n

A Windows Security pop-up window will confirm the installation IntervalZero software. Click Install to
continue.

n

A warning that setup was unable to interface with the power management service may appear. Since RTX
does not use Power Management services, this warning can be ignored. Click OK to continue.

After the installation of RTX, you must reboot your system for the RTX Runtime installation to complete.
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IMPORTANT! To confirm that the system has been rebooted after the installation of RTX, go to the
Control tab of the RTX Properties control panel. If status is Undetermined, the system needs to be
rebooted. If status is Stopped you can start the subsystem by clicking the Start button.
To make custom changes to the Windows Image (.wim) file of a target system that has been installed and is
running, use the Deployment Image Servicing and Management (DISM) tool.

Product Activation and Configuration
RTX activation and configuration is done silently using a Command Line utility.
NOTE: RTX requires .NET 4.0 for configuration on Windows 7 systems.

Recommended License Type:
Node Locked – Pool Activation. For more information, see License Types.

Activating your Product
To activate your product (Internet connection required):
1. Navigate to the RTX\bin directory and run RtxActivationUtil.exe as Administrator.
2. Type the -a flag, and then provide your activation key. For example:
RtxActivationUtil.exe -a IZRTX-111-2222-3333-4444-5555-IZTCP-111-2222-33334444-5555-IZSDK-111-2222-3333-4444-5555
NOTE: You can find your activation key in the email you received from IntervalZero Sales.
3. If running from a command prompt, the activated components are displayed:

Configuring your System
Setting the boot configuration (.NET 4.0 required):
1. Navigate to the RTX\bin directory.
2. Run RtxActivationGUI.exe as Administrator.
3. Provide the number of Windows -w and RTSS -r processors. For example, to assign 3 processors to
Windows and 5 processors to RTX, you would type:
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RtxActivationGUI.exe -w 3 -r 5
4. Restart the system.
NOTE: For complete usage information, see Appendix A: RTX Activation and Configuration Usage.
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5
Scenario 5: Deploying RTX in an
Image for Auto Activation

In this scenario, RTX is installed and configured for auto activation before an image is created for
deployment.

Deployment Steps
Deployment of RTX in this scenario requires the following steps:
1. Product Installation
2. Product Activation and Configuration
3. Image Creation
4. RTX Activation on the Target System

Product Installation
Before Installing
Before beginning the installation, do the following:
l

Review the RTX 2016 Install Guide.

l

Verify that your configuration meets the system requirements described in the RTX 2016 Install Guide.
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l

l

l

l

l

You must have administrator privileges on your system. Log on with administrator privileges or start
the RTX installation using Run as Administrator.
IntervalZero recommends that you de-select the Windows “Automatically reboot” option for Startup
and Recovery from the Advanced tab of the System Properties page of the Windows Control Panel. Deselecting this parameter allows you to view blue screen information.
Exit all Windows programs.
If a previous version of RTX is already installed on the system, you must uninstall it and reboot the
system before you can install RTX 2016. If an update was applied to that previous version, you must also
manually uninstall the update.
RTX requires Microsoft .NET 4.0 to be installed on the system. If it is not already installed on the system,
you will be prompted to have RTX install it for you.

NOTE: When you upgrade your operating system (for example, from Windows Vista to Windows 7),
you must uninstall and then reinstall RTX after the OS upgrade.

Performing the Install
To install RTX:
1. Download the self-extracting executable, RTX_2016_Setup.exe, from the IntervalZero web site:
http://www.intervalzero.com/rtx-2016-downloads/#tab-1
NOTE: The download page also includes:
l

The RTX Merge Module installer:
RTX_2016_MM_Setup.exe

For access to evaluation kits, visit the Evaluation page at
http://www.intervalzero.com/.
In the form that appears, select RTX 2016 from the drop-down list, fill out the
contact information, and click Submit.
2. Double-click the file RTX_2016_Setup.exe.
3. On Windows 7 or Vista machines, if necessary, click Continue in the User Account Control dialog box.
NOTE: If you are not a member of the Administrators group, this prompt requires you to enter
the password for the Administrators account.
4. Click Next in the IntervalZero RTX installation Welcome window.
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NOTE: If Microsoft .NET 4.0 is not already installed on your machine, you will be prompted to
have RTX install it at this point.
5. Read the End User License Agreement, select I accept the terms in the license agreement and then
click Next.
6. Enter your user name, organization, and e-mail address, and then click Next.
7. Optionally, change to a destination other than the default:
C:\Program Files\IntervalZero\RTX.
Click Next in the Destination Folder screen.
8. In the Custom Setup screen, select the components and features you want to install, then click Next.
NOTE: If you select the Win32 Enabled Managed Code Support feature during installation, the
Managed Code DLL will be registered by default.
NOTE: The Custom Setup screen only displays features in Visual Studio versions that are
currently installed. If you install Visual Studio after installing RTX, you can add support for new
functionality by changing the RTX installation through Add/Remove Programs.
9. In the Ready to Install the Program screen, select whether you want Desktop Icons and/or Start Menu
Icons and then click Install.
10. If prompted, click Install to install the RTX Plug and Play driver. (Windows 7 or Vista)
11. Click Finish in the installation Completed screen.
12. Activate your product.

Product Activation and Configuration
You can set up your system to auto-activate your product and configure the RTX boot configuration using a
Command Line utility.

Recommended License Type:
Node Locked – Pool Activation. For more information, see License Types.
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Auto-Activating RTX
To activate your product (Internet connection):
1. Navigate to the RTX\bin directory and run RtxActivationUtil.exe as Administrator.
2. Type the -aa flag, and then provide your activation key. For example:
RtxActivationUtil.exe -aa IZRTX-111-2222-3333-4444-5555-IZTCP-111-2222-33334444-5555-IZSDK-111-2222-3333-4444-5555
NOTE: You can find your activation key in the email you received from IntervalZero Sales.
This will set up the system to activate upon next reboot.

To activate your product (no Internet connection):
1. Navigate to the RTX\bin directory and run RtxActivationUtil.exe as Administrator.
2. Type the -af flag, and then provide your activation key. For example:
RtxActivationUtil.exe -af IZRTX-111-2222-3333-4444-5555-IZTCP-111-2222-33334444-5555-IZSDK-111-2222-3333-4444-5555 fingerprint.rfp
NOTE: You can find your activation key in the email you received from IntervalZero Sales.
This will set up the system to generate a fingerprint file on the desktop. The fingerprint can then be
used to generate a license file.

Configuring your System
Setting the boot configuration (.NET 4.0 required):
1. Navigate to the RTX\bin directory.
2. Run RtxActivationGUI.exe as Administrator.
3. Provide the number of Windows -w and RTSS -r processors. For example, to assign 3 processors to
Windows and 5 processors to RTX, you would type:
RtxActivationGUI.exe -w 3 -r 5
4. Restart the system.
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NOTE: For complete usage information, see Appendix A: RTX Activation and Configuration
Usage.

Image Creation
Once RTX has been installed and successfully activated and configured, create an image for deployment on
the target system.

RTX Activation on the Target System
Once the image is deployed on the target system, reboot the machine. RTX will be automatically activated if
the machine was connected to the Internet. If it was not connected, the image will have a fingerprint file that
can be used to license the system.
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Appendix A:
RTX Activation and Configuration
Usage

The Command Prompt flags supported by the RTX Activation Utility are listed below.

RtxActivationGUI.exe (Windows 7 and Above)
Usage
RtxActivationGUI.exe
Parameters
-w

Proc - Sets the number of Windows processors. Requires -r. Restart is required.

-r

Proc - Sets the number of RTSS processors. Requires -w . Restart is required.

RTXActivationUtil.exe
Usage
RtxActivationUtil.exe
Parameters
-a

Key - Creates and activates the RTX license.

-af

Key file - Automatically creates the fingerprint file on next reboot.

-ef

Key file - Exports a fingerprint file.

-lf

File - Imports the license file.

-aa

Key - Automatically activates the key on the next boot or reboot.
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-if

File - Imports the activation file.

-w

Proc - Sets the number of Windows processors. Requires -r. Restart is required.
Example:
RtxActivationUtility.exe -w 3 -r 5

-r

Proc - Sets the number of RTSS processors. Requires -w. Restart is required.
Example:
RtxActivationUtility.exe -w 3 -r 5

-v

Displays the license that is currently activated.

-listdongles Provides a list of the dongles connected to the machine.
Detects the ID of the dongle connected to the machine.
detectdongle
-h

Displays help.
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Resources
You can find more information on RTX deployment scenarios in these resources:

Installation, Activation, and Configuration
l

RTX 2016 Install Guide

l

RTX 2016 Silent Install Guide

l

RTX 2016 Install Guide for Merge Modules

l

MiniTutorial: Including RTX 2016 Runtime with Windows Embedded Standard 7

General Product Information
l

RTX Product Documentation > http://www.intervalzero.com/technical-support/guides-andminitutorials/
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Getting Support
IntervalZero offers a number of support options for RTX users, including technical support and the
IntervalZero Website.

Third-Party Support
If you are a customer who purchased an IntervalZero product through a third-party reseller, contact the
reseller for support.

Contacting Technical Support by Phone
For technical support related to installing and using RTX, you can call 1-781-996-4481. At the prompt, press
3 for Support.
Hours are Monday - Friday, 8:30 a.m. – 5:30 p.m. US Eastern time (GMT-500), excluding holidays.

Before Calling Technical Support
Please have the following information ready before calling IntervalZero Technical Support:

Your Support ID
Customers who purchase direct support receive an e-mail address and password for use when accessing the
IntervalZero support Website.

The Version Number of Your RTX Software
Before calling technical support, determine the version of RTX installed on your system. Also, check to make
sure you have a valid maintenance contract.
To obtain the RTX version number:
1. Click Start > All Programs > IntervalZero > RTX 2016 > RTX Properties.
2. Record the RTX version that is shown in the RTX Properties window.

IntervalZero Website
The IntervalZero Customer Support Web page is located at:
http://www.intervalzero.com/technical-support/
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The IntervalZero support web pages provide electronic access to the latest product releases,
documentation, and release notes. With a valid e-mail address and password, you can access the online
problem report database to submit new issues or to obtain the status of previously reported issues.
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